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Overview 

'Stellar Phoenix Word Recovery' is designed to recover corrupted 'Microsoft Word' (.DOC, .DOCX) files. 

This software scans selected 'Word' documents and uses an advanced algorithm to restore 'Word' files 

back to their original state. The recovered files can either be saved at their original location on the hard 

disk, or at any user-specified location. 

The software gives three types of recovery options to users- 'Simple Repair', 'Advance Repair', and 

'Raw Recovery'. The last two options are available only for .doc file while the first one can be applied on 

both .doc and .docx files. 

User can preview 'Word' files in three different modes - 'Full document', 'Filtered Text', and 'Raw Text'. 

'Full document' view displays scanned file exactly as a 'Word' file opened in 'Microsoft Word'. 'Filtered 

text' shows only the text of the 'Word' file without formatting and other attributes of the content. 'Raw Text' 

shows machine-readable format of the file. 

User can search for 'Word' files in folders and drives. You can save individual or all files. In addition, you 

can save files at the original location or at a location of your preference. 

Key Features of Stellar Phoenix Word Recovery 

 Provides options of 'Simple Repair', 'Advance Repair', and 'Raw Recovery'. 

 Preview of files in 'Full document', 'Filtered Text', and 'Raw Text' formats. 

 Searches for 'Word' documents (.doc, .docx) in a folder or a drive. 

 Recovers text, font (color, size, name), hyperlinks and preserves formatting of original document. 

 Recovers 'Header/Footer'. 

 Recovers 'Bookmarks'. 

 Recovers 'Charts'. 

 Recovers 'Comments'. 

 Recovers 'Footnote/Endnote'. 

 Recovers 'Autoshapes'. 

 Recovers 'Pictures'. 
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 Recovers 'Fields'. 

 Recovers 'Controls'. 

 Recovers 'Caption'. 

 Generates 'Log report' for further analysis. 

 Supports MS Word 2000, XP(2002), 2003, 2007 and 2010. 

 Compatible with Windows NT/ 2000/ XP/ 2003/ Vista /Windows 7. 
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Installation Procedure 

Before installing the software, ensure that your computer meets the minimum system requirements to 

install 'Stellar Phoenix Word Recovery'. 

 

 Minimum System Requirements 

Processor : Pentium Class 

Operating System: Windows NT / 2000 / XP / Vista / Windows 7 

Memory : 512 MB ( 1 GB recommended) 

Hard Disk : 50 MB of free space 

MS Office: 2000 / 2002 (XP) / 2003 / 2007 / 2010 

To install the software: 

1. Double-click 'StellarPhoenixWordRecovery.exe' file to open 'Stellar Phoenix Word Recovery 

Setup Wizard'. Click 'Next'. 

2. In 'Specify Destination Location' window, specify the destination where 'Stellar Phoenix Word 

Recovery' should be installed. Click 'Next'. 

3. In 'Select Start Menu Folder' window, specify the destination where program shortcuts should be 

stored. Click 'Next'. 

4. In 'Select Additional Tasks' window, check the check boxes of required icons. Click 'Next'. 

5. In 'Ready to Install' window, click 'Install'. 

6. Click 'Finish' to exit setup wizard after completion of installation process. 

 

You can clear 'Launch Stellar Phoenix Word Recovery' check box to stop the automatic launch of the 

software. 
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Launching the Software 

You can use any of the following methods to start 'Stellar Phoenix Word Recovery':  

 

 Click 'Start' -> 'Programs' -> 'Stellar Phoenix Word Recovery' -> 'Stellar Phoenix Word 

Recovery'.  

 Double click icon on the 'Desktop'.  

 Click 'Stellar Phoenix Word Recovery' icon in 'Quick launch'.  
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User Interface 

'Stellar Phoenix Word Recovery' has a very simple and user friendly 'Graphical User Interface' (GUI) as 

shown below:  

 

 

 

With 'Menus' and 'Tools' on the user interface, you can access its various features quite easily. 
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Options on Main User Interface 

The different options present on the main user interface are as described below: 

 

Options on Menu Bar:  

 File:  

o Add File(s) to Tree View: Use this to add 'Word' files to the tree view. 

o Remove from Tree: Use this to remove selected files from the tree view. 

o Start Repair: Use this to start the repair process. 

o Advanced Repair: This is used for repair severely corrupted files. 

o Stop: Use this to stop a process in the middle. 

o Exit: This is for closing the application.  

 View 

o Toolbar: Show/Hide the toolbar. 

o Status bar: Show/Hide the 'Status bar'. 

o Message Log: Show/Hide the 'Message Log'. 

 Tools 

o Save Log: It saves the log information. 

o Clear Log: It clears the log information. 

o Raw Preview: This option is used for previewing .doc files in 'Raw Text' format. 

 Help 

o Stellar Phoenix Word Recovery Help: Opens the user guide. 

o Purchase Stellar Phoenix Word Recovery Online: Displays purchase details of the product. 

o Activate Stellar Phoenix Word Recovery: Purchase details of the product. 

o View support section: Opens 'Stellar support' section webpage. 

o Visit knowledge base: Opens 'knowledge base' article webpage. 

o Submit Enquiry: Opens the login page, to submit enquiry. 

o Updates: Opens 'Update Wizard' for live updates. 

o About Stellar Phoenix Word Recovery: Contains generic information about the product. 
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Options on Tool Bar: 

 

Add File(s) to 

Tree View: 

 

 

Use this tool to open 'Stellar Phoenix Word Recovery box', where you can 

select and search for 'Microsoft Word' files from folders and volumes. In 

addition, you can start scanning files using 'Scan' button in  this dialog box. 

Remove File(s) 

from tree view: 

 

 

 

Removes files that are checked from the tree view. 

Start Repair: 

 

 

 

This option lets you start recovering corrupted 'Word' file(s.) 

Advance Repair: 

 

 

 

Processes advance repair of selected file(s). 

Stop: 

 

 

 

This option lets you stop an ongoing process. 

Stellar Phoenix 

Word Recovery 

Help: 

 

 

 

 

Use this option to access 'User Manual' if you face any issue while using the 

product. 

Updates: 

 

 

 

Lets you download latest updates of the software. 

Purchase: 

 

 

 

Shows links from where you can buy the software.   

About Stellar 

Phoenix Word 
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Recovery: 

 

Shows general information about the software such as product name, 

version, operating system it supports, etc. 
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How to Order? 

'Stellar Phoenix Word Recovery' can be purchased by making payments online using a credit card. 

Please visit, http://www.stellarinfo.com/file-repair/word-repair/buy-now.php for more information and to 

place an order. 

 

You can find various offers, available at the site to buy the software. For evaluation, you can also 

download the latest demo version of the software from the web site.  

If you have demo version of the software installed, click 'Purchase'  icon on the main user interface to 

open a dialog box as shown below.  

 

Click 'Buy Now' link to go further with the purchasing process.  

Once the payment is complete, an activation serial number along with activation details is sent via e-mail. 
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How to Activate? 

Once the 'Serial Key' has been received after purchasing the software, the software can be activated. 

To register the software: 

1. Run demo version of the software. 

2. On the 'Help' menu, Click 'Activate Stellar Phoenix Word Recovery'. 

3. Type 'Name' and 'Key'. Click 'OK'. 
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How to Update? 

There are periodical software updates provided by 'Stellar Information Systems Ltd'. for 'Stellar Phoenix 

Word Recovery' software. The software updates should be done to keep the software up-to-date. The 

updates can be a newly added functionality, a new feature, a new service or any other information that 

can be important for improvement. 'Stellar Phoenix Word Recovery' software can be updated over 

internet. To update the application, follow these steps: 

 

 Click on 'Updates'  button in application tool bar or select 'Updates' option in 'File' menu. 

'Update Wizard' dialog box is displayed. 

 Click 'Next'. A busy timer shows that updates are being searched. After the search is finished, 

you will get a message about availability / non-availability of updates. 

 If updates are not available, click 'Cancel' to close the wizard.  

 If updates are available, click 'Next' to download update files from the server. When the process 

is complete, the software will upgrade to the latest version. 

 

 Demo version of the software can not be updated. 

 If major version of the software is available, you have to purchase the software to upgrade it. 
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Features 

'Stellar Phoenix Word Recovery' has many features that make it unique among other products. It has the 

ability to perform whole drive scan to search all the 'Word' files and to repair corrupt files without any kind 

of modification to original files. The main features can be listed as follows: 

 

 Search for 'Word' Files: 'Stellar Phoenix Word Recovery' gives a unique user-friendly option to 

search for 'MS Word' files with .doc and .docx extension if the exact location of file is unknown or 

forgotten. You can search your file in whole hard drive, volume or a folder. Search result shows 

the name, size, creation date and modification date of the files. These options help in selecting 

and identifying the required 'Word' file for recovery. 

 Preview of Files: 'Stellar Phoenix Word Recovery' gives an option to preview corrupted 'Word' 

file after scanning. User can preview in three different formats - Full document, Filtered text and 

Raw text. Preview option enables user to take decision like whether to further examine the file or 

simply repair the file.  

 Advance Repair: The software gives user the option to go for 'Advance Repair' if the corrupted 

file has not been repaired or the recovered file is not satisfactory. This option is available for .doc 

files only. 

 Raw Recovery: If user is not satisfied with the result even after doing 'Advance Repair', he can 

go for 'Raw Recovery'.Like 'Advance Repair', this option too is available for .doc files only. It 

recovers everything that is found in the file in the format of 'Raw Text' (machine readable format).  

 Generation of 'Log Report': 'Log report' contains details of the recovery process such as 

beginning of the process, end of the process, name of the corrupted 'Word' file etc.  
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How to Uninstall the Software? 

In two ways you can uninstall 'Stellar Phoenix Word Recovery'.  

 

Click 'Start' -> 'All Programs' -> 'Stellar Phoenix Word Recovery' -> 'Uninstall Stellar Phoenix Word 

Recovery'. Follow on screen instructions to completely remove the software, including registry entries 

from your computer. 

 

Click 'Start' -> 'Control Panel' -> 'Add or Remove Program'. Select 'Stellar Phoenix Word Recovery' 

entry from the displayed list and click 'Change/Remove'. Follow on screen instructions to completely 

remove the software as well as registry entries from your computer. 
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Stellar Support 

Our 'Technical Support' professionals will give solutions for all your queries related to 'Stellar' products.  

You can either Call Us or Go Online to our support section at http://stellarinfo.com/support/. 

For price details and to place the order, click http://www.stellarinfo.com/file-repair/word-repair/buy-

now.php 

Chat Live with an Online technician at http://stellarinfo.com/support/. 

Search in our extensive 'Knowledge Base' at http://www.stellarinfo.com/support/kb.php. 

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php. 

E-mail to 'Stellar Support' at support@stellarinfo.com. 

 

 

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 

USA (Tollfree- Pre Sales Queries)USA 
(Post Sales Queries) 

UK (Europe) 
Australia & Asia Pacific 

Netherlands Pre & Post Sales Support 
Worldwide 

Skype Id 
Email Orders 

+1-877-778-6087 
+1-732-584-2700 
+44-203-026-5337 
+61-280149899 
+31-208-111-188 
+91-921-395-5509 
stellarsupport 
orders@stellarinfo.com  
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Select File(s) 

You can add individual file, all files in a single folder or multiple files in 'Stellar Phoenix Word Recovery' 

software for recovery.  

To add file(s): 

Click 'Add File to Tree View'  icon on the tool bar  

or  

Select 'Add File to Tree View' option in 'File' menu.  

 

'Stellar Phoenix Word Recovery' 

dialog box opens as shown here: 

 

To select a single 'Word' file  

 Specify drive to search for 

files in 'Look in' list box. 

 Click 'Select File' button; 

locate and select the required 

'Word' file in the 'Open' dialog 

box. Click 'Open', and then 

click 'Add'. 

 

To select all 'Word' files in a 

single folder: 

 Specify drive to search for 

files in 'Look in' list box. 

 Click 'Select Folder' option. 

 

To select multiple 'Word' files: 

 Specify drive to search for 

files in 'Look in' list box. 

 Click 'Find File(s)'.  
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When you select 'Select Folder' or 'Find File(s)' option, the application starts searching for 'Word' files in 

the specified folder/drive and displays a list of files found accordingly. 

 

 

 

 

Check the check boxes of files 

that needs to be recovered. 

'Scan' button will be enabled. 

 

Now you can start the process 

of scanning by pressing 'Scan' 

button. 



 

17 

 

Preview Files 

 

After scanning, 'Stellar Phoenix Word 

Recovery' shows preview of corrupted 

'Word' files. It helps you evaluate files 

before repairing. You can view the 

content of files in three different formats - 

'Full document', 'Filtered text' and 'Raw 

text'. These file previews are available 

according to the state of the damage. In 

case of severely damaged files, the 

software provides plain text preview of the 

file content in 'Filtered text' and 'Raw text' 

view. If you want to preview a file, double 

click on the required file in the tree view. 

 

To preview the file: 

Click on file in the left pane or right click and select 'Preview'. Click 'Full Document,' 'Filtered Text' or 

'Raw Text' tab in the middle-box of main user interface, to preview files in 'Word' format or in plain text.  

 

 

 

'Raw Text' tab is displayed only when 'Raw Preview' option is selected from the 'Tools' menu. 

This option is available for .doc files only. 

 Full document View 
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This will show preview of document in 'Microsoft Word' format. It shows all formatting, embedded 

images, text formatting, hyperlinks and other attributes of document.  

 

 

 Filtered Text 

This shows the content of documents in plain text. Click 'Filtered Text' tab to view this format. 

 

 

 

 Raw Text 
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This shows content of the file as machine-readable text. Preview in raw format is available for .doc 

files only. To view files in this format, select .doc file from the tree and select 'Raw Preview' from 

'Tools'  menu. 'Raw Text'  tab will appear. Click this tab to see file preview. 
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Repair Word Files 

'Stellar Phoenix Word Recovery' recovers 'Microsoft Word' files and allows you to save them at your 

preferred location. You can recover individual or multiple files using the software. In addition, you can 

save recovered files in original 'Word' document format, in plain text format, or in machine-readable 

format. 

To recover corrupted 'Microsoft Word' files: 

1. Select file(s) to be recovered and start scanning. 

2. Preview files and decide upon the format you want to save file(s) in. 

3. Check the check boxes of files that needs to be covered. Now you have two options: 

 Normal Repair: This option is available for .doc and .docx files both. 

 Advance Repair: This option is available for .doc files only. 

 

 

For 'Normal Repair', click 'Start Repair'  

icon on the tool bar or right click on selected 

file and choose 'Repair' option from the 

drop down menu. 'Save Document' dialog 

box opens as shown here: 

 

Select 'Default Location' or 'Select New 

Folder'. Former will save the file to its 

original location from where it is selected. 

Latter allows you to specify new destination.  

 

Decide whether to save files in 'Full 

Document', Filtered Text' or 'Raw Text' 

format and click 'OK'. Repair process will 

start and file(s) will be saved in desired 

format at specified location. 
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For 'Advance Repair', click 'Advance Repair' 

  icon on the tool bar or right click on 

selected file and choose 'Advance Repair' 

option from the drop down menu. You will be 

asked for destination to save file(s) as shown in 

the figure on left. 

 

Here, choose either default or new location as 

the destination for saving file(s) and click 'OK'. 

All selected files will be repaired and saved at 

the specified location. 
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Remove Files From Application Node 

You can remove files from the 'Stellar Phoenix Word Recovery' node displayed after scanning of files. If 

there are undesired files in tree, you can remove these files without closing the software. 

To remove files: 

1. Check the check boxes of files need to be removed. 

2. Click 'Removes file(s) from Tree View'  icon on tool bar or select 'Remove  file(s) from 

Tree View' option in 'File' menu, . All selected files will be removed. 

 

By default, all files are checked when you add files in the tree. If you click 'Remove files from Tree 

View' icon, all files will be removed. Therefore, ensure that you checked the check boxes of only 

required file.  
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Copyright 

Stellar Phoenix Word Recovery software, accompanied user manual and documentation are copyright of 

Stellar Information Systems Ltd., with all rights reserved. Under the copyright laws, this user manual 

cannot be reproduced in any form without the prior written permission of Stellar Information Systems Ltd. 

No Patent Liability is assumed, however, with respect to the use of the information contained herein. 

 

Copyright © 1995-2011 by Stellar Information Systems Ltd. INDIA 
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Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

STELLAR INFORMATION SYSTEMS LTD PROVIDES NO WARRANTY WITH REGARD TO THIS 

MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY EXPRESSLY 

DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY 

PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR INFORMATION 

SYSTEMS LTD ASSUMES NO LIABILITY FOR ANY DAMAGES INCURRED DIRECTLY OR 

INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS OR OMISSIONS 

CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE MANUAL. IN 

NO EVENT SHALL STELLAR INFORMATION SYSTEMS LTD, BE LIABLE FOR ANY INCIDENTAL, 

CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, WHETHER BASED ON TORT, 

CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION WITH THIS MANUAL OR ANY 

OTHER INFORMATION CONTAINED HEREIN OR THE USE THEREOF. 
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Trademarks 

Stellar Phoenix Word Recovery® is a registered trademark of Stellar Information Systems Ltd. 

 

Windows 2000®, 2003®, XP®, Windows Vista®  and Windows 7® are registered trademarks of 

Microsoft® Corporation Inc. 

 

All Trademarks Acknowledged. 

 

All other brands and product names are trademarks or registered trademarks of their respective 

companies. 
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License Agreement 

Stellar Phoenix Word Recovery 

Copyright © 1995-2011 by Stellar Information Systems Ltd. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Phoenix Word Recovery. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Systems Ltd. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar Phoenix Word Recovery with which this License is included, you may return the 

complete package unused without requesting an activation key within 30 days after purchase for a full 

refund of your payment. 

 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar Phoenix Word Recovery. For purposes of this License, if you have a valid single-user license, you 

have the right to use a single Licensed Copy of Stellar Phoenix Word Recovery. If you or your 

organization has a valid multi-user license, then you or your organization has the right to use up to a 

number of Licensed Copies of Stellar Phoenix Word Recovery equal to the number of copies indicated in 

the documents issued by Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Phoenix Word Recovery may either be used by a single person or used 

non-simultaneously by multiple people who use the software personally installed on a single workstation. 

This is not a concurrent use license. 

All rights of any kind in Stellar Phoenix Word Recovery, which are not expressly granted in this license, 

are entirely and exclusively reserved to and by Stellar Information Systems Ltd. You may not rent, lease, 

modify, translate, reverse engineer, decompile, disassemble or create derivative works based on Stellar 

Phoenix Word Recovery nor permit anyone else to do so. You may not make access to Stellar Phoenix 

Word Recovery available to others in connection with a service bureau, application service provider or 

similar business nor permit anyone else to do so. 
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Warranty Disclaimers and Liability Limitations. 

Stellar Phoenix Word Recovery and all accompanying software, files, data and materials are distributed 

and provided AS IS and with no warranties of any kind, whether expressed or implied. In particular, there 

is no warranty for the quality of data recovered. You acknowledge that good data processing procedure 

dictates that any program including Stellar Phoenix Word Recovery must be thoroughly tested with non-

critical data before there is any reliance on it and you hereby assume the entire risk of all use of the 

copies of Stellar Phoenix Word Recovery covered by this License. This disclaimer of warranty constitutes 

an essential part of this License. In addition, in no event does Stellar authorize you or anyone else to use 

Stellar Phoenix Word Recovery in applications or systems where its failure to perform can reasonably be 

expected to result in a significant physical injury or in loss of life. Any such use is entirely at your own risk 

and you agree to hold Stellar harmless from any and all claims or losses relating to such unauthorized 

use. 

 

In no event shall Stellar Information Systems Limited or its suppliers be liable for any special, incidental, 

indirect, or consequential damages whatsoever (including, without limitation, damages for loss of 

business profits, business interruption, loss of business information, or any other pecuniary loss) arising 

out of the use of or inability to use the software product or the provision of or failure to provide support 

services, even if Stellar Information Systems Limited has been advised of the possibility of such 

damages. In any case, Stellar Information Systems Limited’s entire liability under any provision shall be 

limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 

violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

 

Copyright ©1995-2011 by Stellar Information Systems Ltd. All rights reserved. 
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FAQs 

1. What does the demo version of  'Stellar Phoenix Word Recovery' do? 

Demo version of the software only scans file(s) and shows their preview. To save recovered 

file(s), you need to purchase and register the software. 

2. Can I use 'MS Word' while 'Stellar Phoenix Word Recovery' software is running? 

No, please make sure that 'MS Word' is closed while 'Stellar Phoenix Word Recovery' is running. 

3. Can I view my original file after recovery? 

Yes, you can view your original file because 'Stellar Phoenix Word Recovery' does not make any 

changes in the original file but saves the recovered file as another file. 

4. What styles, formats and objects are recovered in 'Word' document using 'Stellar Phoenix 

Word Recovery'? 

'Stellar Phoenix Word Recovery' preserves formatting of original document and recovers text, font 

color, font size, and hyperlinks of the document. The software also recovers tables, embedded 

images, and other attributes of 'Word' files like header and footer. 

5. I have forgotten the location of corrupted ' MS Word' file(s) to be recovered. Can the 

software help me find those files? 

Yes, 'Stellar Phoenix Word Recovery' gives you option to search for 'Word' file(s). For full 

instructions, please refer 'To select multiple files' option in Select File(s) topic of this help 

manual. 

6. I cannot see any button or menu for 'Raw Recovery'. How can I go for it? 

It is very simple. You only have to choose 'Raw Text' under 'Save As' heading in Save Document 

dialog box. The software will run the process of 'Raw Recovery' and the 'Word' file will be 

recovered in machine readable format. 
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About Stellar 

Stellar Information Systems Ltd. is a trusted name in the field of Data Recovery and Data Protection 

Software for more than a decade. 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for 

almost all Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of Email. 

More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

For more information about us, please visit www.stellarinfo.com. 

 


